
Generative Assembly Structural Analysis

 Site Map

 Preface

 What's New?

 Getting Started

 Basic Tasks

 Workbench Description

 Index

  
© Dassault Systèmes 1994-99. All rights reserved.

file:///E|/www/ansdocr7/GasEnglish/gasug.doc/src/gasugwn.htm
file:///E|/www/ansdocr7/CATEnglish/commain.doc/src/spenot.htm


Site Map
Preface

Using This Guide
More Information

What's new
Getting Started

Entering Analysis Connections Workbench
Creating Analysis Face Face Connection
Creating Analysis Welding Point Connection
Creating Property Connections
Computing the Static Case

Basic Tasks

Before You Begin
Analysis Connections

Creating Face Face Connections
Creating Distant Connections
Creating Welding Point Connections

Property Connections

Creating Fastened Connections
Creating Slider Connections
Creating Contact Connections
Creating Bold Tightening Connections
Creating Virtual Rigid Bold Tightening Connections
Creating Virtual Spring Bold Tightening Connections
Creating Pressure Fitting Connections
Creating Rigid Connections
Creating Smooth Connections
Creating Spot Welding Connections

Workbench Description

Property Connections Toolbar
Analysis Connection Toolbar

Index

file:///E|/www/ansdocr7/GasEnglish/gasug.doc/src/gasugwn.htm


Preface
ELFINI Structural Analysis, Generative Part Structural Analysis and Generative
Assembly Structural Analysis Version 5 products allow you to rapidly perform first order
mechanical analysis for 3D parts systems.

As a scalable line of products, ELFINI Structural Analysis Version 5 along with Generative
Part Structural Analysis and Generative Assembly Structural Analysis can be
cooperatively used with other current or future companion  products such as  Part Design,
Assembly Design and Generative Drafting. The widest application portfolio in the industry is
also accessible through interoperability with CATIA Solutions Version 4 to enable support of the
full product development process from initial concept to product in operation.

 
The Generative Part Structural Analysis application is intended for the casual user.
Indeed, its intuitive interface offers the possibility to obtain mechanical behavior
information with very few interactions. The dialog boxes are self explanatory and require
practically no methodology, all defining steps being commutative.

 
The Generative Assembly Structural Analysis product has been designed as an
integrated extension to Generative Part Structural Analysis enabling the study of the
mechanical behavior of a whole assembly. The product has been conceived with the
same "easy to learn" and "fun to use" ergonomics principles. 



 
The ELFINI Structural Analysis product is a natural extensions of both above
mentioned products, fully based on the V5 architecture. It represents the basis of all
future mechanical analysis developments. 

 



The ELFINI Structural Analysis User's Guide has been designed to show you how to analyze
a system consisting of single parts or of assemblies of parts, operating within a specified
environment. There are several ways for undergoing a part to external actions. There are also
several types of useful output information. This book aims at illustrating these various
possibilities.  

 

 
Using This Guide
More Information

 



Using This Guide
This book is intended for the user who needs to quickly become familiar with Analysis
Connections Version 5. The user should be familiar with basic concepts such as document
windows, standard and view toolbars.

To get the most out of this guide, we suggest you start reading and performing the step-by-step
tutorial "Getting Started". This tutorial will show you how to analyze a part from scratch.

The "Basic Tasks" section presents the main capabilities of the product. Each individual task is
carefully defined and explained in detail. 

 

 



Where to Find More Information
Prior to reading this book, we recommend that you read:

Generative Structural Analysis (GPS and EST) user's guide
Infrastructure User's guide Version 5
Part Design User's Guide
Conventions chapter

 

 



Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you
recognize and understand important concepts and specifications. The following text
conventions may be used:
       The titles of CATIA documents appear in this manner throughout the text.
       File -> New identifies the commands to be used.

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button, whenever you read

Select (menus, commands, geometry in graphics area, ...)
Click (icons, dialog box buttons, tabs, selection of a location in the document window,
...)
Double-click
Shift-click
Ctrl-click
Check (check boxes)
Drag
Drag and drop (icons onto objects, objects onto objects)

Drag
Move

Right-click (to select contextual menu)

Graphic conventions are denoted as follows:

indicates the estimated time to accomplish a task.

indicates a target of a task.

indicates the prerequisites.

indicates the scenario of a task.

indicates tips



indicates a warning.

indicates information.

indicates the end of a task.

indicates functionalities that are new or enhanced with this Release.
Enhancements can also be identified by a blue-colored background in the left-hand
margin.

 



Getting Started
This tutorial will guide you step-by-step through your first Generative Assembly Structural
Analysis session, allowing you to get acquainted with the product. You just need to follow the
instructions as you progress.

In this tutorial, you will

1.  create Analysis Connections (Analysis Connections workbench),

2.  add properties to these connections (Generative Structural Analysis

workbench) and then compute the CATAnalysis document.

 

Entering Analysis Connections Workbench
Creating Analysis Face Face Connection

Creating Analysis Welding Point Connection
Creating Property Connections

Computing the Static Case

 
These tasks should take about 15 minutes to complete.

 



Entering Analysis Connections
Workbench

The Analysis Connections workbench of the Generative Assembly Structural Analysis
product let's you add constraints to existing geometry. You can also add these constraints
using Product workbench (Design mode). If so, the geometry will be over-constrained.

 
Open the LandingGear.CATProduct document from the sample directory.
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1. Select Start-> Analysis & Simulation -> Analysis Connections from the menu bar.

Now that you entered the Analysis Connections workbench ...

... the following commands are available:

In other words, you can create Face Face, Distant or Welding point connections.

In this tutorial, you will create Connections (Analysis Connections workbench of the
Generative Assembly Structural Analysis product), add property connections
(Generative Structural Analysis workbench of the Generative Part Structural Analysis
product) and then compute the CATAnalysis document.

 

 

 



Creating a Face Face Connection
Face Face Analysis Connections are connections used for connecting either faces that are
parallel to each others or concentric cylinders, on an assembly model.

 Remember that you entered the Analysis Connections workbench of the
Generative Assembly Structural Analysis product.

 

This task shows you how to create a Face Face Connection.

1. Select the Face Face Connection  icon.

The Analysis Face Face Connection dialog box is displayed. 
2. Select a first face on the assembly.

To manipulate the product more easily click with the middle mouse button on the product.

The Analysis Face Face Connection dialog box displays the selected face.



 
3. Select a second face on the assembly.

 
The Analysis Face Face Connections dialog box displays the selected faces.

4. Click OK in the Face Face dialog box.

A symbol appears on each connected face.



The Analysis Connection Manager object appears in the specification tree.

 

 

 

  



Creating a Welding Point Connection
Welding Point Analysis Connections are connections used for projecting welding points
onto two faces, on an assembly model.

 You are still in the Analysis Connections workbench of the Generative Assembly
Structural Analysis product

This task shows you how to create a Welding Point Connection.

1. Select Start -> Analysis & Simulation -> Analysis Connections.

2. Select the Welding Point Connection  icon.

The Analysis Welding Points Connection dialog box is displayed. 
3. Select a first face on the assembly.

The Analysis Welding Points Connection dialog box appears as shown here:



4. Select a second face on the assembly.

The Analysis Welding Points Connection dialog box appears as shown here:



5. Multi-select a set of points in a single Open Body, on the product.

OR

5. Select a set of points in a single Open Body, on the specification tree. In this case select
Open_body.1.

The Analysis Welding Points Connection dialog box appears as shown here:



6. Click OK in the Analysis Welding Points Connection dialog box.

Symbols appear on the points connecting the faces.

Analysis Connection Manager appears in the specification tree.

 

 



Adding Property Connections
Property Connections are used to specify the boundary interaction between bodies in an
assembled system. Once the geometric assembly positioning constraints are defined at
the Product level, the user can specify the physical nature of the constraints. 

 You will now enter in the Generative Structural Analysis workbench of the
Generative Part Structural Analysis product. For this, Select Start-> Analysis &
Simulation -> Generative Structural Analysis from the menu bar and select the Static
Analysis case and click OK in the New Analysis Case dialog box.

 
1. Select the desired Property Connection icon.

Connections

Advanced Connections

2. Select the previously created Analysis connections (either from the specification tree or
on the geometry).

 
Selecting the Spot Welding icon and the
Welding Point connection:

You create this Spot Welding Property
connection:



   

The Spot Welding Connection object
appears in the specification tree.

 Repeat the same operation to create fastened Property connections on the Face-Face
connection previously created.

 

  



Computing the Static Case
The Compute command is most often applied to Analysis Case Solutions (which are particular
types of objects sets). In this case, it generates the analysis case solution, along with partial
results for all objects involved in the definition of the Analysis Case.

The primary Static Solution Computation result consists of a displacement vector whose
components represent the values of the system degree of freedom. This result can be further
processed to produce other results such as stresses, reaction forces, etc.    

The program can compute simultaneously several Solution objects sets, with optimal parallel
computation whenever applicable.  

 You are still in the Generative Structural Analysis workbench of the Generative
Part Structural Analysis product.

 
 

 

This task will show you how to compute the Static Case Solution of a Finite Element Model on
which you previously created connections.

 

1. Click the Storage Location icon  .

The Current Storage Location dialog box is displayed.

2. If needed, change the path of the Storage Result and/or Computation Data directory (Results
Data and Computation Data fields) to another directory. 

 

 

 
The Results and Computation Data are stored in one single file with given extensions:

xxx.CATAnalysisResults
xxx.CATAnalysisComputations



 

3. Click the Compute icon   .

The Compute dialog box appears.
The Elfini Storage Location dialog box disappears.

4. Select the All default value proposed for defining which are the objects sets to be updated.

5. Click OK in the Compute dialog box to launch the computation.

At the bottom right of the screen, a series of status messages (Meshing, Factorization, Solution)
informs you of the degree of advancement of the computation process.

 

 

 



Basic Tasks
The basic tasks you will perform in the Generative Assembly Structural Analysis workbench
are:

Before You Begin
Analysis Connections
Property Connections



Before You Begin
 

 

Before you begin you should be familiar with the following basic concepts on:
Analysis strategy
Analysis Connections workbench

 

 

  
A Standalone Analysis Connection Workbench

 

When you create a connection, you generally first create an assembly constraint in the Assembly Design workbench.
Then, in the Generative Structural Analysis workbench, you add a property on this constraint (fastened, pressure
fitting, bolt and so forth). This property generates a Mesh part. The property is propagated to the above mentioned
Mesh part. 

 

Why you will use Analysis Connections workbench:

In some cases, Assembly Design constraints are not sufficient to modelize connections from an Analysis viewpoint:

In order to support properties, users often need to define too many constraints using the  Assembly Design
workbench, leading to over-constrained models that cannot be updated.

1.  

It is impossible to define constraints that are not positioning constraints but connection constraints (for example :
connecting one face from one solid with one face from another solid, these faces being not necessarily
coincident).

2.  

In the case of surface parts assemblies, it is not possible to define positioning constraints.3.  

It is impossible to modelize welding spot connections.4.  

In order to meet these different needs, a new workbench called Analysis Connection was added to the Generative
Assembly Design product. Analysis Connection let you create all these Connections dedicated to Analysis modeling.

 

 



  

About Analysis Connections Workbench

   

The Analysis Connections workbench allows you creating constraints that are not design constraints.

The Analysis Connections workbench let's you create face face, distance or welding constraints (called connections).
As a user, you may need to add design face-to-face connections in order to create property constraints afterwards
(Generative Structural Analysis workbench). As a result, a given number of these design constraints need to be
de-activated so that the model is not over-constrained. You may also need to add design constraints at a given distance
(this constraint goes through a virtual point) so that you can simulate a part that was not designed.

 

 

  
What Type of Property For What Type of Connection ?
1. For Connections Between Two Surfaces

 

Connection Property  
Assembly Design Analysis Connection

Coincidence  Contact  Offset  Face Face Distant  Welding 

Fastened        

Slider         

Contact            

Rigid      

Smooth      

Spot welding          

 

 



 

2. For Connections Between Two Parts

 

Connection Property
Assembly Design Analysis Connection

 Coincidence   Contact   Offset   Face
Face   Distant   Welding 

Fastened   ( )  

Slider    ( )  

Contact   ( )  

Rigid      

Smooth      

Bolt tightening        

Pressure fitting        

Virtual bolt tightening        

Virtual spring bolt
tightening        

Spot welding          

 
 

3. For Connections Between a Part and a Surface

 



Connection Property Assembly Design Analysis Connection

 Coincidence   Contact   Offset   Face Face   Distant   Welding 

Fastened        

Slider         

Contact            

Rigid      

Smooth      

Spot welding          

 

 

 



Analysis Connections

   

Analysis Connections are assembly connections cannot be created from the
Generative Assembly Structural Analysis workbench. They are some kind of
constraints that are not design constraints. If needed, you will then be able to add
property connections on this assembly.

 

Creating Face Face Connections: connect either faces that are parallel to each
others or concentric cylinders, on an assembly model.

Creating Distant Connections: connect any part from an assembly with or without
point type geometrical elements, on an assembly model. 
Creating Welding Points Connections: project welding points onto two parallel
faces, on an assembly model.

 

  



Creating a Face Face Connection
 

 

 Face Face Analysis connections are connections used for connecting either faces
that are parallel to each others or concentric cylinders, on an assembly model.

 
This task shows you how to create a Face Face Connection.

Open the Sample18.CATAnalysis document.

Make sure that you entered the Analysis Connections workbench of the Generative
Assembly Structural Analysis product.

 
1. Select the Face Face Connection  icon.

The Analysis Face Face Connections dialog box is displayed. 

                                                            
2. Select a first face on the assembly.
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3. Select a second face on the assembly.

The Analysis Face Face Connection dialog box appears as shown here:

4. Click OK in the Analysis Face Face Connections dialog box.

 
A symbol appears on each connected face.
Analysis Connection Manager appears in the specification tree.



Creating a Distant Connection

 Distant Analysis connections are connections used for connecting any part from
an assembly with or without point type geometrical elements, on an assembly model. 

 
This task shows you how to create a Distant Connection. This is very useful when you want to
benefit from the representation of a part without actually designing this part.
Open the Sample02.CATProduct document.

Make sure that you entered the Analysis Connections workbench of the Generative
Assembly Structural Analysis product.

 

1. Select the Distant Connection  icon.

The Analysis Distant Connection dialog box is displayed. 

                                                            
2. Select a first face on the assembly.
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The Analysis Distant Connection dialog box appears as shown here.

 
3. Select a second face on the assembly.



 
4. Click OK in the Analysis Distant Connection dialog box.

A virtual point is automatically created and the distance connection will go through this virtual
point.

OR

4. If needed, select a point and then click OK in the Analysis Distant Connection dialog box.

The Distant Analysis Connection.1 object now appears in the specification tree.



 
A symbol appears on each connected face.
Analysis Connection Manager appears in the specification tree.

 

                                                                         

 

  



Creating a Welding Point Connection

 Welding Point Analysis connections are connections used for projecting welding
points onto parallel faces, on an assembly model.

 
This task shows you how to create a Welding Point Connection.

Open the Sample03.CATProduct document: you created a set of 3D points on the assembly
(Open Body).

Make sure that you entered the Analysis Connections workbench of the Generative
Assembly Structural Analysis product.

 
1. Select the Welding Point Connection  icon.

The Analysis Welding Points Connection dialog box is displayed. 
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2. Select a first face on the assembly.

The Analysis Welding Points Connection dialog box is updated: 

 
3. Select a second face on the assembly.



The Analysis Welding Points Connection dialog box is updated: 

 
4. Multi-select a set of points in a single Open Body.



The Analysis Welding Points Connection dialog box is updated: 

 

5. Click OK in the Analysis Welding Points Connection dialog box.

Symbols appear on each connected face.



The Spot Welding Analysis Connection.1 object now appears in the specification tree.

 

                                                                         

 

 



Property Connections

Property connections are assembly connections used to specify the boundary
interaction between bodies in an assembled system. Once the geometric assembly
positioning constraints are defined at the Product level, the user can specify the
physical nature of the constraints. 

 

Creating Fastened Connections: Fastens bodies together at their common interface.

Creating Slider Connections: Fastens bodies together at their common interface in
the normal direction while allowing them to slide relative to each other in the
tangential directions.

Creating Contact Connections: Prevents bodies from penetrating each other at a
common interface

Creating Pressure Fitting Connections: Prevents bodies from penetrating each other
at a common interface

Creating Bolt Tightening Connections: Prevents bodies from penetrating each other
at a common interface

Creating Virtual Rigid Bolt Tightening Connections: Takes into account pre-tension
in a bolt-tightened assembly in which the bolt is not included.

Creating Virtual Spring Bolt Tightening Connections:  Specifies the boundary
interaction between bodies in an assembled system.
Creating Rigid Connections: Fastens bodies together at a common rigid interface.

Creating Smooth Connections: Fastens bodies together at a common soft interface.

Creating Spot Welding Connections: Fastens bodies together at a common soft
interface.

 



Creating Fastened Connections

 A Fastened Connection is the link between two bodies which are fastened
together at their common boundary, and will behave as if they were a single body. From a
finite element model viewpoint, this is equivalent to the situation where the corresponding nodes
of two compatible meshes are merged together. However, since bodies can be meshed
independently, the Fastened Connection is designed to handle incompatible meshes. 

The Fastened Connection relations take into account the elastic deformability of the interfaces.

The program proceeds as follows:
each node of the finer surface mesh is projected parallel to the local outer normal of the
first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection direction
with the second surface mesh (extrapolated at the face boundary by roughly half an
element width).    
if a projection point exists, the start node is connected by a kinematical spider element to
all nodes of the element face on which the projection point has landed.
a set of join-type relations (involving interpolation using element shape functions and a
rig-beam relations) is computed between the start node degree of freedom and the
connected nodes degree of freedom.      

Thus, the Fastened Connection generates at most as many spider kinematical elements as there
are nodes on the finer surface mesh for which a projection onto the opposite surface mesh
exists.  

 
This task shows how to create a Fastened Connection between two parts.

 
You can use the sample16.CATAnalysis document: you applied constraints to the assembly
(Assembly Design workbench). 

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model  containing a Static Analysis
Case from this assembly. 

 
1. Click the Fastened Connection icon

. 

The Fastened Connection dialog box is
displayed.
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2. Select the assembly constraint
previously created in the Assembly
Design workbench. 

The only allowed constraint type is
Contact between surfaces. 

3. Click OK to create the Fastened
Connection. 
A symbol representing the Fastened
Connection is visualized on the
corresponding faces.

A Fastened Connection object appears in
the features tree under the active Nodes
and Elements objects set.



 
The Finite Element Model contains two Mesh objects, one for each part of the assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols. 

 

 



Creating Slider Connections

 A Slider Connection is the l two bodies which are constrained to move together in
the local normal direction at their common boundary, and will behave as if they were allowed
to slide relative to each other in the local tangential plane. Since bodies can be meshed
independently, the Slider Connection is designed to handle incompatible meshes. 

The Slider Connection relations take into account the elastic deformability of the interfaces.

The program proceeds as follows:
each node of the finer surface mesh is projected parallel to the local outer normal of the
first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection direction
with the second surface mesh (extrapolated at the face boundary by roughly half an
element width).    
if a projection point exists, the start node is connected by a kinematical spider element to
all nodes of the element face on which the projection point has landed.
a set of join-type relations (involving interpolation using element shape functions and a
rig-beam relations) is computed between the start node degrees of freedom and the
connected nodes degrees of freedom.
these relations are projected on the local normal direction yielding a single scalar relation
between the start node degrees of freedom and the connected nodes degrees of
freedom.         

Thus, the Slider Connection generates at most as many spider kinematical elements as there are
nodes on the finer surface mesh for which a projection onto the opposite surface mesh exists.  

 
This task shows how to create a Slider Connection between two parts.

You can use the sample16.CATAnalysis document: you applied constraints to the assembly
(Assembly Design workbench). 

 Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model  containing a Static Analysis
Case from this assembly. 
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1. Click the Slider Connection icon

. 
The Slider Connection dialog box is
displayed.

2. Select an assembly constraint
previously created in the Assembly
Design workbench. 

The only allowed constraint type is
Contact between surfaces. 

3. Click OK in the Slider Connection
dialog box to create the Slider
Connection. 
A symbol representing the Slider
Connection is visualized on the
corresponding faces.



A Slider Connection object appears
in the features tree under the active
Nodes and Elements objects set.

The Finite Element Model contains two Mesh objects, one for each part of the assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols. 

 

  



Creating Contact Connections

 

 A Contact Connection is the link between two part bodies which are prevented
from inter-penetrating at their common boundary, and will behave as if they were allowed to
move arbitrarily relative to each other as long as they do not come into contact within a
user-specified normal clearance. When they come into contact, they can still separate or slide
relative to each other in the tangential plane, but they cannot reduce their relative normal
clearance. Since part bodies can be meshed independently, the Contact Connection is designed
to handle incompatible meshes. 

The Contact Connection relations take into account the elastic deformability of the interfaces.

The Contact cannot be generated on two surfaces or between a surface and a part.

The program proceeds as follows:
each node of the finer body surface mesh is projected parallel to the local outer normal of
the first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection direction
with the second body surface mesh (extrapolated at the face boundary by roughly half an
element width).    
if a projection point exists, the start node is connected by a node-to-face element with
contact property to all nodes of the element face on which the projection point has landed.
a set of join-type relations (involving interpolation using element shape functions) is
computed between the projection point degrees of freedom and the degrees of freedom of
the element face nodes (the projection point virtual degrees of freedom are eliminated in
the process).
rigid body kinematical relations are computed between the start node and the projection
node.
after the elimination of the projection point degrees of freedom, a contact relation is
generated by projecting these relations in the local normal direction yielding a single
scalar inequality between the start node degrees of freedom and the degrees of freedom
of the element face nodes, with a right-hand side equal to the user-defined clearance.

Thus, the Contact Connection generates at most as many node-to-face elements with contact
property as there are nodes on the finer surface mesh for which a projection onto the opposite
surface mesh exists.  

 
This task shows how to create a Contact Connection between two parts.



Open the sample16.CATAnalysis document: you applied constraints to the assembly (Assembly
Design workbench). 

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model  containing a Static Analysis
Case from this assembly. 

 
1. Click the Contact

Connection icon . 
The Contact Connection dialog
box is displayed.

 

The Clearance field can be used to enter an algebric value for the maximum allowed normal
clearance reduction:

a positive Clearance value (used to model a known gap between the surfaces) means that
the surfaces can still come closer until they come in contact. 
a negative Clearance value (used for instance to model a press-fitted clamp between the
surfaces) means that the surfaces are already too close, and the program will have to
push them apart.
the default value used for the Clearance represents the actual geometric spacing between
surfaces. 

 

2. Optionally modify the default value of the Clearance parameter.  

3. Select an assembly
constraint previously created in
the Assembly Design
workbench. 
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The only allowed constraint
type is Contact between body
surfaces. 

4. Click OK in the Contact
Connection dialog box to
create the Contact
Connection. 
A symbol representing the
Contact Connection is
visualized on the
corresponding faces.

A Contact Connection object
appears in the specification
tree under the active Nodes
and Elements objects set.

The Finite Element Model contains two Mesh objects, one for each part of the assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols. 

 

  



  Creating Bolt Tightening Connections

 As a support, the Bolt Tightening Connection requires a surface contact assembly
constraint between the bolt thread and the bolt support tapping. Note that both these surfaces
should be coincident.

Surface 1 and surface 2 are supports for the assembly constraint of surface contact type.

A Bolt Tightening Connection is a connection that takes into account pre-tension in bolt-tightened
assemblies. The computation is carried out according to the two-step traditional approach. In the
first step of the computation, the model is submitted to tension forces relative to bolt tightening by
applying opposite forces on the bolt thread and on the support tapping, respectively. Then, in the
second step, the relative displacement of these two surfaces (obtained in the first step) is
imposed while the model is submitted to user loads. During these two steps, the bolt and the
support displacements are linked in the direction normal to the bolt axis. Since bodies can be
meshed independently, the Bolt Tightening Connection is designed to handle incompatible
meshes. 

The Contact Connection relations take into account the elastic deformability of the interfaces.

The program proceeds as follows:
each node of the finer surface mesh is projected parallel to the local outer normal of the
first surface onto the second surface mesh.



a projection point is located whenever possible at the intercept of the projection direction
with the second surface mesh (extrapolated at the face boundary by roughly half an
element width).    
if a projection point exists, the start node is connected by a node-to-face element with Bolt
Tightening property to all nodes of the element face on which the projection point has
landed.
a set of join-type relations (involving interpolation using element shape functions) is
computed between the degrees of freedom of the start node and the degrees of freedom
of element face nodes (the projection point virtual degrees of freedom are eliminated in
the process).
rigid body kinematical relations are computed between the start node and the nodes of
element face.
after the elimination of the projection point degrees of freedom, these relations are rotated
in a coordinate frame the third vector of which is aligned with the tension direction (bolt
axis).
two scalar equality relations are generated in the first two directions of the coordinate
frame, in order to link the displacement of the start node and the nodes of the element
face in the plane normal to the bolt axis.
a cable relation (the reverse of a contact relation) is generated between the start node and
the nodes of element face in the third direction, generating an inequality.

Thus, the Bolt Tightening Connection generates at most as many node-to-face elements with
Bolt Tightening property  as there are nodes on the finer surface mesh for which a projection
onto the opposite surface mesh exists.  

 
This task shows how to create a Bolt Tightening Connection between two parts.

Open the sample05.CATAnalysis document: you applied constraints to the assembly (Assembly
Design workbench). 

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model from the assembly prior to
beginning this task. 

 
1. Click the Bolt Tightening Connection icon

. 

The Bolt Tightening dialog box is displayed.
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2. Select a constraint on the assembly
previously created in the Assembly Design
workbench. 

 

3. Optionally modify the default value of the
force and orientation parameters. 

Choose either the same or the opposite
orientation so that the graphic representation of
the bolt tightening connection matches the bolt
direction.

 
4. Click OK in the Bolt Tightening dialog box to create the Bolt Tightening Connection. 

A symbol representing the Bolt Tightening
Connection is visualized on the corresponding
faces.

 



Bolt Tightening.1 Connection object appears in
the specification tree under Properties.1.

 

  



Creating Virtual Rigid Bolt Tightening
Connections

 Virtual Rigid Bolt Tightening Connections are used to specify the boundary interaction
between bodies in an assembled system. Once the geometric assembly positioning constraints
are defined at the Product level, the user can specify the physical nature of the
constraints. When creating this connection, both the coincidence constraints and the Analysis
Connections workbench constraints can be selected.

Surface 1 and surface 2 are supports for the assembly constraints of coincidence type.

A Virtual Rigid Bolt Tightening Connection is a connection that takes into account pre-tension in
a bolt-tightened assembly in which the bolt is not included. The computation is carried out
according to the two-step traditional approach. In the first step of the computation, the model is
submitted to tension forces relative to bolt tightening by applying opposite forces on the first
surface (S1) and the second surface (S2) of the assembly constraint, respectively. Then, in the
second step, the relative displacement of these two surfaces (obtained in the first step) is
imposed while the model is submitted to user loads. During these two steps, the rotations of both
surfaces and the translations perpendicular to the coincidence constraint axis are linked together,
while taking into account the elastic deformability of the surfaces. Since bodies can be meshed
independently, the Virtual Rigid Bolt Tightening Connection is designed to handle incompatible



meshes.

The program proceeds as follows:
a central node is created at the centroid of each surface of the assembly constraint
referenced as the support.
for each surface/central node couple, a set of mean (constr-n) relations is generated to
link the average displacement of the central node and the nodes of the surface.
the first central node is linked rigidly to the duplicata of the second central node.
the second central node is linked rigidly to its duplicata except for the translation in the
direction of the coincidence constraint.
in the direction of the coincidence constraint, a cable relation (the reverse of a contact
relation) is generated between translation degrees of freedom of the second central node
and its duplicata.

 
This task shows how to create a Virtual Rigid Bolt Tightening Connection between two parts.

Open the sample11.CATAnalysis document: you applied constraints to the assembly (Assembly
Design workbench). 

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model from the assembly prior to
beginning this task. 

 
1. Click the Virtual Rigid Bolt
Tightening Connection icon . 

The Virtual Rigid Bolt Tightening
dialog box is displayed.

2. Select a constraint on the
assembly previously created in the
Assembly Design workbench.

file:///E|/www/ansdocr7/GasEnglish/gasug.doc/src/samples/sample11.CATAnalysis


3. Optionally modify the default
value of the force and orientation
parameters. 

4. Click OK in the Virtual Rigid Bolt Tightening dialog box to create the Virtual Rigid Bolt
Tightening Connection. 

A symbol representing the Virtual
Rigid Bolt Tightening Connection is
visualized on the corresponding
faces.



Virtual Bolt Tightening.1 Connection
object appears in the specification
tree under Properties.1.

 

  



 Creating Virtual Spring Bolt Tightening
Connections

 Virtual Spring Bolt Tightening Connections are used to specify the boundary
interaction between bodies in an assembled system. Once the geometric assembly positioning
constraints are defined at the Product level, the user can specify the physical nature of the
constraints. When creating this connection, both the coincidence constraints and the Analysis
Connections workbench constraints can be selected.

Surface 1 and surface 2 are supports for the assembly constraints of coincidence type.

Virtual Spring Bolt Tightening Connection is a connection that takes into account pre-tension in a
bolt-tightened assembly in which the bolt is not included. The computation is carried out
according to the two-step traditional approach. In the first step of the computation, the model is
submitted to tension forces relative to bolt tightening by applying opposite forces on the first
surface (S1) and the second surface (S2) of the assembly constraint, respectively. Then, in the
second step, the relative displacement of these two surfaces (obtained in the first step) is
imposed while the model is submitted to user loads. The Virtual Spring Bolt Tightening
Connection takes into account the elastic deformability of the surfaces and since bodies can be
meshed independently, the Virtual Spring Bolt Tightening Connection is designed to handle
incompatible meshes.



The program proceeds as follows:
a central node is created at the centroid of each surface of the assembly constraint
referenced as the support.
for each surface/central node couple, a set of mean rigid body (constr-n) relations is
generated to link the average displacement of the central nodes and the nodes of the
surface.
the first central node is linked to the duplicata of the second central node using a
tightening element. This element generates:
- a set of equality relations linking both nodes according to the rigid body motion except for
the translation in the direction of the element.
- a cable inequality relation (the reverse of a contact element) in the direction of the
element. This cable relation is used to enforce the relative displacement of both surfaces
at the second step of the computation.
the second central node is linked to its duplicata using a spring element the characteristics
of which are defined by the user.

 
This task shows how to create a Virtual Spring Bolt Tightening Connection between two parts.

You can use the sample14.CATAnalysis document: you applied constraints to the assembly
(Assembly Design workbench). 

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model from the assembly prior to
beginning this task. 

 
1. Click the Virtual Spring Bolt
Tightening Connection icon . 

The Virtual Spring Bolt Tightening
dialog box is displayed.

file:///E|/www/ansdocr7/GasEnglish/gasug.doc/src/samples/sample14.CATAnalysis


2. Select a constraint on the
assembly previously created in the
Assembly Design workbench.

3. Optionally modify the default
value of the force and stiffness
parameters. 

 
4. Click OK in the Virtual Spring Bolt Tightening dialog box to create the Virtual Spring Bolt
Tightening Connection. 



A symbol representing the Virtual
Spring Bolt Tightening Connection
is visualized on the corresponding
faces.

Virtual Spring Bolt Tightening.1
Connection object appears in the
specification tree under
Properties.1.

  



 Creating Pressure Fitting Connections

 The Pressure Fitting Connection uses assembly surface contact constraint as a
support. A Pressure Fitting Connection is the link between two bodies which are assembled
in a Pressure Fitting configuration, more precisely when there are interferences or overlaps
between both parts. Along the surface normal, the connection behaves as a contact connection
with negative clearance value (positive overlap). The difference lies in the tangential directions
where both parts are linked together. Since bodies can be meshed independently, the Pressure
Fitting Connection is designed to handle incompatible meshes. 

The Pressure Fitting Connection relations take into account the elastic deformability of the
interfaces.

The program proceeds as follows:
each node of the finer surface mesh is projected parallel to the local outer normal of the
first surface onto the second surface mesh.
a projection point is located whenever possible at the intercept of the projection direction
with the second surface mesh (extrapolated at the face boundary by roughly half an
element width).
if a projection point exists, the start node is connected by a a node-to-face element with
contact property to all nodes of the element face on which the projection point has landed.
a set of join-type relations (involving interpolation using element shape functions) is
computed between the degrees of freedom of the start node and the degrees of freedom
of element face nodes (the projection point virtual degrees of freedom are eliminated in
the process).
rigid body kinematical relations are computed between the start node and the nodes of
element face.
these relations are rotated in a coordinate system the third vector of which corresponds to
the normal of the local surface.
after the elimination of the projection point degrees of freedom, a pressure fitting relation
is generated between the start node and the projected node, transforming the scalar
equality relation into an inequality relation with a right-hand side equal to the minus
user-defined overlap.
two scalar equality relations are generated in the tangential plane to link the tangential
displacement of the start node and its projection.

Thus, the Pressure Fitting Connection generates at most as many node-to-face elements with
Pressure Fitting property as there are nodes on the finer surface mesh for which a projection
onto the opposite surface mesh exists.  

 
This task shows how to create a Pressure Fitting Connection between two parts.



Open the sample12.CATAnalysis document: you applied constraints to the assembly (Assembly
Design workbench). 

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model from the assembly prior to
beginning this task. 

 
1. Click the Pressure Fitting
Connection icon  . 

The Pressure Fitting dialog box is
displayed.

 
The Overlap field can be used to enter an algebraic value for the maximum allowed normal
clearance reduction:

a positive Overlap value (used for instance to model a press-fitted clamp between the
surfaces) means that the surfaces are already too close, and the program will have to
push them apart.
a negative Overlap value (used to model a known gap between the surfaces) means that
the surfaces can still come closer until they come in contact. 
the default value used for the Overlap represents the actual geometric spacing between
surfaces.

The overlap indicates the interference between both parts. It is intended to be positive.

2. Select an assembly constraint
previously created in the Assembly
Design workbench. 

file:///E|/www/ansdocr7/GasEnglish/gasug.doc/src/samples/sample12.CATAnalysis


3. Optionally modify the default
value of the overlap parameter.  In
this case, enter 0.001mm.

4. Click OK to create the Pressure
Fitting Connection. 
A symbol representing the Pressure
Fitting Connection is visualized on
the corresponding faces.

 

 

Pressure Fitting.1 Connection
object appears in the specification
tree under Properties.1.

 

  



Creating Rigid Connections

 A Rigid Connection is the link between two bodies which are stiffened and
fastened together at their common boundary, and will behave as if their interface was
infinitely rigid. Since bodies can be meshed independently, the Rigid Connection is designed to
handle incompatible meshes. 

The Rigid Connection relations do not take into account the elastic deformability of the
interfaces.    

The program proceeds as follows:
a central node is created at the midpoint between the centroids of the two systems of
points represented by the nodes of the two meshes.
this node is connected by a rig-beam element to each node of the first and of the second
meshes.   
a set of rig-beam relations is generated between the central node degree of freedom and
the connected nodes degree of freedom.       

Thus, the Rigid Connection generates as many rig-beam kinematical elements as there are
nodes on the two surface meshes.

 
This task shows how to create a Rigid Connection between two parts.

Open the sample17.CATAnalysis document: you applied constraints to the assembly (Assembly
Design workbench). 

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model  containing a Static Analysis
Case from this assembly. 

 
1. Click the Rigid Connection icon

. 
The Rigid Connection dialog box is
displayed.   
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2. Select the Coincidence assembly
constraint previously created in the
Assembly Design workbench. 

The allowed assembly constraint
types are Coincidence, Offset and
Angle. 

3. Click OK in the Rigid Connection
dialog box to create the Rigid
Connection. 
A symbol representing the Rigid
Connection is visualized on the
corresponding faces.

A Rigid Connection object appears in
the features tree under the active
Nodes and Elements objects set.



The Finite Element Model contains two Mesh objects, one for each part of the assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols. 

 

  



Creating Smooth Connections

 A Smooth Connection is the link between two bodies which are fastened together
at their common boundary, and will behave approximately as if their interface was soft. Since
bodies can be meshed independently, the Smooth Connection is designed to handle
incompatible meshes. 

The Smooth Connection relations take approximately into account the elastic deformability of the
interfaces. The approximation is based on a least squares fit of a slave node degree of freedom
rigidly linked to the master nodes (element shape functions are ignored).    

The program proceeds as follows:
a central node is created at the midpoint between the centroids of the two systems of
points represented by the nodes of the two meshes.
this node is connected by two spider elements to all nodes of the first and of the second
meshes.   
a set of mean (constr-n) relations is generated between the central node degree of
freedom and the connected nodes degree of freedom.       

Thus, the Smooth Connection generates two spider kinematical elements.

 
This task shows how to create a Smooth Connection between two parts.

Open the sample17.CATAnalysis document: you applied constraints to the assembly (Assembly
Design workbench). 

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model  containing a Static Analysis
Case from this assembly. 

 

1. Click the Smooth Connection icon

. 
The Smooth Rigid dialog box is
displayed.   
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2. Select the Coincidence assembly
constraint previously created in the
Assembly Design workbench. 

The allowed assembly constraint types
are Coincidence, Offset and Angle. 

3. Click OK to create the Smooth
Connection. 
A symbol representing the Smooth
Connection is visualized on the
corresponding faces.

A Smooth Connection object appears in
the features tree under the active Nodes
and Elements objects set.

The Finite Element Model contains two Mesh objects, one for each part of the assembly.
The sizes of the two meshes are different as can be seen by comparing the Mesh Size
symbols. 



 

  



 Creating Spot Welding Connections

 A Spot Welding Connection is the link between two bodies, using analysis
welding point connections.

 

This task shows how to create a Spot Welding Connection between two parts.

Open sample18.CATAnalysis sample.

Make sure you enter the Generative Structural Analysis workbench of the Generative Part
Structural Analysis product and create a Finite Element Model  containing a Static Analysis
Case from this assembly. 

 

1. Click the Spot Welding Connection icon  .

The Spot Welding Connection dialog box is displayed.   

 

2. Select the Supports to be assigned spot welding
connections. In this case, select the Analysis welding
points (Joint Body) that were previously created.
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The Spot Welding Connection dialog box is updated.

 

3. Click OK in the Spot Welding Connection dialog box

 

A Spot Welding Connection object appears in the
specification tree under the Properties objects set.

 



 

 



Workbench Description
This section contains the description of the icons and menus which are specific to the
Generative Assembly Structural Analysis product, either:

from the Generative Part Structural Analysis workbench 

or

from the Analysis Connections workbench 

The menu items can be found on the top border of your analysis document.

The icons are grouped in toolbars, which can be found on the right and bottom border of
your analysis document.



 

Property Connections Toolbar
Analysis Connection Toolbar



Property Connections Toolbar

The Mesh Specification toolbar (Generative Assembly Structural Analysis workbench)
gives access to the following tools for defining Property Connections and Advanced
Connections:

 

      

 

Connections
See Fastened Connections

See Slider Connections

See Contact Connections

See Rigid Connections

 

See Smooth Connections

 

Advanced Connections

See Pressure Fitting Connections

See Bolt Tightening Connections

See Virtual Rigid Bolt Tightening Connections

See Virtual Spring Bolt Tightening Connections

See Spot Welding Connections

 

 



Analysis Connections Toolbar

The Analysis Connections toolbar (Analysis Connections workbench) gives you direct
access to the following tools for defining Analysis Connections:

 

      

 

Analysis Connections

See Face Face Connections

See Distant Connections

See Welding Points Connections
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